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Some general information:

This presentation uses InterSpec v1.0.7_rc1
◦ Windows, Linux, macOS: https://github.com/sandialabs/InterSpec/releases

◦ Installation: unzip downloaded file, and place resulting directory where ever you would like (e.x., C:\Program Files\InterSpec) and 
manually add a shortcut to the InterSpec.exe executable to your start menu and/or desktop.

◦ macOS: https://apps.apple.com/us/app/interspec-radiation-analysis/id1476886954

◦ Currently phone and tablet version of  InterSpec is at v1.0.3, but this presentation is still largely applicable.  
You can install InterSpec through the app store, namely:
◦ iPhone/iPad: https://itunes.apple.com/us/app/interspec-radiation-analysis/id1447080767

◦ Android: https://play.google.com/store/apps/details?id=gov.sandia.interspec

This presentation and all example spectrum files can be found at 
https://sandialabs.github.io/InterSpec/ under tutorials section, under the overview heading

The “live” version of  this presentation takes about 3 hours, and there is a part 2

InterSpec is completely open-source (LGPL v2.1), and code available from:
◦ https://github.com/sandialabs/InterSpec

◦ https://github.com/sandialabs/SandiaDecay

◦ https://github.com/sandialabs/SpecUtils

Support, bug reports, and requests: InterSpec@sandia.gov
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Topics to be covered

Part 1 (this presentation)
◦ InterSpec’s Capabilities

◦ A demonstration of  using InterSpec for analysis

◦ Using InterSpec
◦ Interacting with spectra, viewing options, spectrum files, saving work, reference photopeak lines, peak-fitting, nuclide search

◦ Energy calibration
◦ Manual adjustment, graphical adjustment, fitting from photo-peaks, multi-file, non-linear deviation pairs

◦ Fitting activity and shielding
◦ Multiple isotopes, shielding types, limitations

Part 2
◦ Nuclide ID

◦ Including with shielding, neutron reactions, and x-rays 

◦ Creating detector response functions

◦ Advanced activity and shielding fit
◦ Self-attenuating sources, isotopics, nuclide age

◦ Other calculations available
◦ Dose, gamma flux, nuclide decay

◦ Example problems to work together
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InterSpec’s Capabilities

genera l  f ea tures



Some InterSpec Capabilities

◦ InterSpec helps perform peak-based spectral analysis of  radioactive isotope data collected with most 
handheld, backpack, search, portal, and laboratory based equipment

◦ Helps perform nuclide identification, determine source activity, shielding around source, characterize 
detectors, identify neutron interactions, and inspect other data features

◦ Reads >100 spectrum file format variants, and exports to a dozen or so useful export formats

◦ A comprehensive nuclide database (~4k nuclides) with all aging calculations performed on-the-fly

◦ Extensive shielding database (NIST + GADRAS + generic)

◦ Lots of  features to make analysis quick and convenient
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Some InterSpec Capabilities (cont)6

A quickly and easy way to view spectrum files 

and fit peaks
Fit for nuclide activities, shielding amounts, 

isotopics, and ages

Assist with nuclide ID



Some InterSpec Capabilities (cont)7

Perform various nuclide decay calculations and get reference information

Develop detector response functions (efficiency + FWHM)



Some InterSpec Capabilities (cont)8

Dose calculations, or determining 

activity/distance/shielding from 

a dose rate

Cross-section calculator

1/r2 calculator

Gamma flux calculator



Some InterSpec Capabilities (cont)9

View and edit spectrum 

file meta-data

Plot measurement GPS 

points and load from 

selected region (may 

not be enabled for all 

releases).

Perform data-mining 

on repositories of 

spectrum files



Some InterSpec Capabilities (cont)10

Customize colors

Can be run pretty much anywhere

Export and import CSV files, or 

similar, in a bunch of places 

Stores settings, previous work, and application 

states to internal database (everything stays on 

your computer – InterSpec doesn’t 

communicate of connect to anything external 

to your computer)

Has help pages 

associated with most 

tools



The different platforms11

On phones, great for:
◦ Checking that data taken in the field is good

◦ Referencing nuclide half-life, decay chains, and decay 
products

◦ Calculating gamma dose or decay times

◦ 1/r2 calculations

◦ Quick nuclide identification or activity determination

◦ Nearly all features are available on phones, but 
involved or complex analysis is a little cumbersome

On tablets and computers:
◦ Everything you can do on phones

◦ Complex or detailed nuclide identification, activity, 
shielding, or age determination 

◦ Challenging peak-fitting or nuclide identification

◦ Detector characterization

◦ File type conversion, and meta-information editing

◦ Searching your spectrum file archives

◦ …



What InterSpec isn’t:12

InterSpec is not a magic easy button – all features are interactive – doesn’t 

tell you the answer automatically, but assists the user to perform analysis

Not full-spectrum analysis, i.e., not GADRAS.

Does not do data acquisition - only accepts data already taken



A demonstration of using 
InterSpec for analysis

Load  spec t r a ,  per fo r m nuc l ide  ID,  f i t  ac t iv i t y



A quick example of using InterSpec to perform nuclide ID and 
determine activity and shielding of a spectrum. 

intro_LaBr_10Percent_50cm.n42
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Using InterSpec

In te rac t ing  w i th  spec t r a



Loading Spectra16

The easiest way to load a spectrum file is just to drag-n-drop files from your computer
◦ You can open the file as either foreground, background, or a secondary spectrum, depending on where you drop the file

◦ If  you open as a foreground, and the file also contains a background, InterSpec will load that as well

The InterSpec→Open File… menu option lets you browse for file

And you can also associate file types to be automatically opened when you double-click them in the operating system, using the standard OS 
preferences. 

On iOS, Android, and macOS the file type associations should be automatic



Interacting with spectra

Zoom in: click and drag to the right to highlight the region you want to zoom in to.  When you let go of  the mouse, it will 
zoom in.  

Zoom out: click and drag to left; zooming out will happen continuously

To pan left or right: hold control key and use mouse to drag left and right. Or click and drag labels (numbers) on the x-axis

Or you can use the up and down mouse-wheel (and trackpad equivalent) to zoom in and out, and wheel left/right to pan

Touch screens work to, and basics are reasonably intuitive

You can also zoom in on the y-axis by holding the Alt-key (mac: command-key) clicking and dragging down, and do same 
thing but up to zoom out.  Or you can click and drag on y-axis labels (numbers), or for more control use the mouse-wheel 
when mouse is over y-axis area 
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Interacting with spectra (cont)

View → “Show Energy Slider” will bring up a strip chart

◦ Drag on edges to change displayed energy ranges, or click and drag on dark part to pan

◦ Especially useful for really inspecting HPGe specra
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Basic peak-fitting

Usually to fit a peak, just double click near it.

Want to add on other nearby peak?  Just double click again.

If  you move your mouse to the edge of  the Region Of  Interest (ROI), you can adjust ROI extent.

Right-click on a peak to get a menu to add or remove a peak from a ROI
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Peak Fitting (cont)

Holding control and dragging across a region lets you fit for multiple peaks in a ROI 
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Peak Fitting (cont) 21

There is also an automated peak search that works pretty well

◦ Does not use the currently showing reference lines, or detector response function (DRF) to identify peaks

◦ Does let you keep peaks that only belong to nuclide(s) the reference lines are showing for

◦ Gets most peaks pretty well, and then you can usually go back through and quickly cleanup any issues 



Peak Fitting (cont.)

As a last resort, if  InterSpec just really refuses to add a peak where you want one, on the “Peak Manager” 
tab, there is an “Add…” button that gives you more control over adding the peak and overrides statistical 
tests and such to force adding one
◦ This is usually only necessary for peaks of  dubious statistics or shape, or when there is a small peak “on the side” 

of  a larger peak

◦ After adding a peak this way you can further modify it, or you can join the new peak to the continuum of  a 
previous peak 
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Peak Fitting (cont)

You can also right-click on a peak and choose “Peak Editor…” from the popup menu to have more 
control over fitting a peak.

You can fix some of  the peak quantities, and fit for other ones, manually adjust some of  the 
parameters, select a continuum type, and more
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Peak Fitting (cont)

You can download a CSV of  your peaks from the “Peak Manager” tab

◦ This CSV is compatible with some other programs that use CSV for peak information
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There is also an option to propagate peaks from 
your previous spectrum to newly opened spectra

If  you drag-n-drop that CSV back onto InterSpec
after opening a different spectrum file, it will try 
to fit for the same energy peaks – useful if  you 
work with the same isotope a lot



Peaks

A key aspect of  peaks in InterSpec is that you can associate them with a nuclide, x-ray, or reaction

◦ The peak is actually associated with a specific gamma-line of  the nuclide/x-ray/reaction

Doing this lets you

◦ Keep track of  nuclide ID

◦ Fit for energy calibration, nuclide activity, isotope age, shielding, detector response function, calculate fluxes, …
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Peaks (cont.)

The easiest way to associate a peak with a given gamma-line, is to show reference photopeaks before fitting for the peak

◦ When you fit for the peak it will pick-up the association if  the reference line is reasonably close to the fit peak

◦ If  there are multiple gamma lines near, or within, the peak, the correct one will almost always be chosen

◦ While fitting for activity/shielding InterSpec will compensate for the other gamma-lines that may contribute to the peak, or if  multiple isotopes contribute

◦ By default the peak color will be the same as the reference lines 
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Peaks (cont.)

Right-clicking a peak and going to “Change Nuclide” 
item will bring up a decent selection of  suggested 
nuclides
◦ Suggestions based on energy, other peaks in spectrum, 

currently showing reference lines, and a general suggestion 
algorithm
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You can click on any of  the peak tables 
to edit the nuclide and photopeak.

◦ On “Peak Manager” tab there is also a 
“Nuc. From Ref.” as well

The peak-editor also lets 
you select the nuclide and 
energy



Peaks (cont.)

Peaks default to being Gaussians sitting 
on top of  a polynomial continuum
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Peaks can also be “data defined” 
meaning their amplitude is the area 
between the continuum observed 
counts

You can choose the order 
polynomial to fit as the continuum, 
or you can use a “global cont.”
◦ The global continuum is calculated 

for the entire spectrum using a 
relaxation method 

◦ There is a “Skew Type” option, that 
will likely be much improved in the 
next version of  InterSpec

Recommend sticking with Gaussian + 
Polynomial unless it really isn’t working



Peaks (cont.)

Peaks can share a continuum

◦ Usually InterSpec will do a decent job of  having peaks share a continuum when its useful, but you can always 
right-click on a peak (on touch, hold down on the peak for a second) and choose to “Combine Cont. 
Right/Left” or “Own Continuum”. 
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Having multiple files open

When you open a new spectrum file, all your previous files get kept in memory 
and any work done on previous spectra is not lost

You can go back to any of  the previous spectra easily
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Files with multiple samples

If  a file has multiple measurements inside of  it, you can also select which samples you want to 
display
◦ If  you want to use multiple samples summed, you can enter text like:

◦ “1-10” to sum samples 1 through 10

◦ “2,3,5-7” to sum samples two, three, and five through seven 

◦ If  you need to sum samples across files, see the “Spectrum Manager…” to create new files with all the 
samples you want
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Saving your work

If  you export to a N42-2012 file, then all of  
your peaks, DRF, and fit activities/shielding 
will be saved inside the file and restored when 
you load back into InterSpec
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Or you can store everything in InterSpecs internal database.  

◦ If  you do this you can “Tag” snapshots of  your work, or if  you 
load the original spectrum some time later, you will be let 
known you can pickup where you left off  before

There is also an option to store your session when you quit 
InterSpec, or switch spectrum files
◦ You cant currently access these auto-saved spectra via the GUI, but 

if  you load the same spectrum file later, a dialog will come up 
asking if  you want to pick up where you left off



In-app help:

Most tools have a help button that will bring up detailed information about that tool.

◦ As always, the help is a work in progress…
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Energy Calibration



Energy Calibration – a primer

Almost all spectrum files use one of:

◦ Polynomial:

◦ The energy of  channel i is: 𝐸𝑖 = 𝑐0 + 𝑐1 × 𝑖 + 𝑐2 × 𝑖2 + 𝑐3 × 𝑖3 + …

◦ Spectrum file gives the coefficients 𝑐𝑗, usually 2 or 3 of  them, but sometimes up to ~5.   

◦ c0 is often times called offset, c1 is gain, c2 quadratic

◦ The most common energy calibration form

◦ Full Range Fraction (FRF):

◦ The energy of  channel i is: 𝑙𝑒𝑡 𝑥𝑖 =
𝑖

#𝑐ℎ𝑎𝑛𝑛𝑒𝑙𝑠
then 𝐸𝑖 = 𝑐0 + 𝑐1𝑥𝑖 + 𝑐2𝑥𝑖

2 + 𝑐3𝑥𝑖
3 +

𝑐4

1+60𝑥𝑖

◦ Primarily used in PCF files (GADRAS and related), but also in some N42-2006 files.

◦ Lower Channel Energies:

◦ The lower energy of  each channel is given.  

◦ Sometimes the upper energy of  last channel is also given

◦ Common in CSV or simple ASCII files, but can also be in N42 and PCF files

A detectors calibration may not always be great, so sometimes adjustments to the coefficients of  
polynomial or FRF coefficients may be necessary before analyzing data – there are a few ways to do 
this in InterSpec
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Energy Calibration (cont.)

You can manually adjust parameter until the 
photopeak's line up with where they 
“should” be
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Energy Calibration (cont.)

You can fit for peaks associated with nuclides, and use those to “fit” for the best coefficients
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1) Select the peaks you want to use for the fit
2) Select which order coefficients 
you want to fit for3) Push “Fit Coeffs”



Energy Calibration (cont.)

You can graphically recalibrate by holding 
Ctrl+Alt and dragging the spectrum to where 
you want
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If  Ctrl+Alt+drag again within 2 minutes, one of  the 
options will be to preserve your last calibration

◦ This is useful to adjust both the gain and offset using a 
low and high energy peak; when you do the second 
calibration this option will keep your previous peak at the 
same location you drug it to 



Energy Calibration (cont)

When you load a new spectrum, and 
its from the same detector as your 
previous spectrum, and the energy 
calibrations are different, you will be 
asked if  you want to keep the 
previous calibration

39

Further options having to do with 
energy calibrations will appear in the 
Energy Calibration tab depending 
on context



Energy Calibration - complications

Some detection systems have multiple physical detectors, and/or may provide many different 
measurements all within the same file

◦ Each detector may have a different energy calibration

◦ The energy for a given detector may change for each sample

In these cases you will have to select how you want the changes applied
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Energy Calibration – complications (cont.)

You can select which detectors, 
samples, and files to apply the 
changes to here

41

You can see the calibrations for 
each detector using this menu, 
which will appear when you load a 
spectrum with multiple detectors



Energy Calibration – complications (cont.)

For multiple detector systems, or where calibration changes throughout file:

◦ If  you manually change a coefficient, the effect of  that change is applied to all the other calibrations in the 
file

◦ E.g., the peaks for all detectors will move the same amount

◦ This isn’t as straight forward as changing the coefficients of  each calibration by the same amount, but InterSpec takes care of  the math

◦ If  you want to adjust the calibration of  just on detector, use the “View” → “Detectors” menu to change 
which detectors are being shown

◦ Options also appear on the GUI to let you apply changes to just the visible samples, or all the samples, or 
just the foreground/background/secondary spectrum

◦ Changes are not applied to other files you may have open, but aren’t being displayed; use the “Multi File Cal…” option for that, or after 
an adjustment, change back to the other file you want, and you should be prompted if  you would like to use the new calibration
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Energy Calibration – nonlinear deviation pairs

Non-Linear deviation pairs are typically used to account for intrinsic non-linearities not captured by a lower-order 
polynomial
◦ Non-linear deviation pairs are typically static over time and temperatures and wont need to be adjusted after initial characterization

The deviation pairs are actually the nodes of  a cubic spline that specifies a change to add on-top of  the polynomial or 
FRF calibration

An example use is:
◦ Use the 239 keV and 2614 keV peak to determine offset and gain

◦ Then if  the 1460 keV K-40 peak is at 1450 keV, you would a deviation pair with energy of  1460 and offset of  10

◦ You would also add a deviation pair with offset 0 at 0 keV, and one with offset of  0 at 2614 keV

Practically, if  you are trying to use a quartic or above calibration, you should consider non-linear deviation pairs
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Fitting activity and shielding



Peak-Based Differential Attenuation Analysis45

Goal: Take gamma spectrum of  radioactive source, and from the spectrum potentially determine:

1. The amount of  shielding

2. The effective atomic number of  shielding

3. The source activity

4. Isotopics of  material

5. The source Age



Differential Attenuation – Pretty Basic Stuff46

The photon cross-section with matter varies by both photon energy and material atomic number



Detector Response Function47

For peak-based spectroscopy, we care about the efficiency of  detecting the full-energy of  incoming 
gammas – i.e., efficiency to see peaks in the spectrum.

The efficiency is commonly given as either:
◦ Intrinsic: A function describing the fraction of  gammas striking the detector face, who’s full energy will be 

absorbed

◦ Absolute: The fraction of  full-energy absorptions , for a source at a given distance

Usually given in a form like: exp(-343.63 + 269.10*log(x) -83.80*log(x)^2 + 13.0*log(x)^3 -1.01*log(x)^4 + 0.03*log(x)^5)



Source Gamma Intensities:48

ENSDF gives us the energy and intensity of  gammas for each nuclide

The Bateman equations let us determine these probabilities for decay chains as a function of  time



Putting it together:49

We know a nuclides output gamma spectrum (as a function of  age)

We know the gamma attenuation (as a function of  energy and atomic number)

We know the efficiency for a gamma to end up in a photopeak (as a function of  energy, source to 
detector distance, and detector face size/shape)

We can fit photopeak’s in spectra to determine their area

----------------------------------------------------------------------

Its now just χ2 or -log(likelihood) fit to figure out the the unknowns



Comparison of Peak-Based analysis to Full Spectrum analysis
50

Advantages of  peak-based:

◦ No background is needed (unless you want to use source peaks that overlap with background peaks)

◦ Does not depend on scattering of  your environment.

◦ For full spectrum you need to characterize the DRF to your environment, ex. concrete floor, 1m high, how big the room is, etc.

◦ Detector characterization much simpler (either do by measuring a couple check sources, or a simple 
GEANT/MCNP calc can be good enough)

◦ Gamma transport through material is trivial; doesn’t really depend on geometry

◦ Peaks and spectral features from nuisance sources only effect you if  they also have a gamma line overlapping 
a peak you want to use of  the isotope of  interest

Disadvantages of  peak-based:

◦ You need at least as many peaks in your spectrum as quantities you want to fit

◦ The broader energy range, the better (see next slide)

◦ E.x. To fit for activity and shielding thickness, you need at least two peaks (three or more is better) – full spectrum analysis can fit for 
atomic number, areal density, and activity of  single-peak sources like Cs-137

◦ You are not using spectral information outside of  the peaks

◦ You aren’t extracting information about scattering environment

◦ Full-spectrum analysis uses more information, so can give better results, but can also give worse results if  
scattering environment is not well characterized



Finding shielding atomic number:51

For energies ≳ 300 keV fitting for both atomic number, and amount of  shielding becomes 
degenerate – so you really want at least one peak bellow 300 keV (preferably a few)



Finding shielding atomic number (cont):52

Atomic Numbers > 20

80 to 400 keV

Energy (keV)

Bottom line: if you want to determine the both effective atomic number, and amount of shielding, using a 

peak-based approach, you want at least one peak below 300 keV, and preferable a few



Fitting activity, shielding, and age in InterSpec

First: fit peaks, associating them with nuclides 
◦ Peaks that are in both the background and foreground do not need to be fit.  Or if  a peak is for a nuclide you don’t 

care about you can skip it

◦ If  you have lots of  peaks for a nuclide, like a HPGe spectrum of  Ra-226, you can maybe fit for just the larger ones
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Fitting activity, shielding, and age in InterSpec (cont.)

From the “Tools” menu, select “Activity/Shielding Fit”
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Activity/Shielding Fit Tool

Select DRF

55

Decide if  you want activity 
and/or age fixed for each 
nuclide

You can select 
peaks to use in 
the fit

Select shielding(s)

Enter distance

Some options

Get an idea of  
how good the 
fit is

Fit for the quantities 
you want



Activity/Shielding Fit Tool (DRF)

If  you click/tap on the detector area, it will bring up this dialog  

◦ We’ll cover DRFs later, but this dialog lets you choose from some generic DRFs that come with InterSpec, 
enter your own DRF equation, upload a DRF, or select from previous DRFs
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Activity/Shielding Fit Tool (peaks to use)57

Any nuclides associated with the peaks you have selected, will appear here

◦ You can manually edit an activity, and choose not to fit it, if  you happen to know it, but not 
the shielding

◦ Not shown above, but age of  nuclides is also editable, or fittable for applicable nuclides

All of  the peaks you have fit for 
the foreground will appear in this 
list.

◦ You can choose if  a peak should 
participate in the fitting process.

◦ We’ll cover strategies for deciding 
if  a peak should be included 
during exercises



Activity/Shielding Fit Tool (shielding)58

◦ The shielding can be either a specific type of  material from InterSpecs database, or it can be a generic material where 
you specify the atomic number (AN) and areal density (AD), or you can enter a chemical formula and density.
◦ You can choose to fit for, or fix, thickness, AN, and AD

◦ You can have multiple shielding's, but of  course this can get degenerate to fit for multiple of  them, especially if  they 
have similar effective atomic numbers

Clicking on these icons will 
toggle between shielding types



Activity/Shielding Fit Tool (shielding cont.)59

If  your shielding contains the same element as one or more of  the nuclides you are fitting for, you will 
be given the option to have the shielding become the source term

◦ In this case self-attenuation is taken into account; especially useful in high-Z materials (W, Th, U, Pu, etc)

◦ InterSpec uses an adaptive quadrature based ray-tracing algorithm to account for self-attenuation and geometric effects

◦ If  there are multiple nuclides composing the shielding you can fit for the isotopics as well



Activity/Shielding Fit Tool (shielding cont.)

InterSpec uses a spherical geometry when self-attenuating sources are used

Nuclides that aren’t part of  shielding's are point-sources at the center of  all shieldings
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2.22 cm solid sphere of  Thorium metal

A 1 cm gap outside the Thorium

A 1.06 cm shell of  wood

Inner shell

Outer shell



Activity/Shielding Fit Tool (distance)

Distance, like times, can be entered in fairly flexible formats; the following are all valid distances:

“1.2cm”, “1ft”, “1 ft 13 in”, “1' 13"”, “3 m”, “3 meters”, “3.6E-2 m”, etc
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The distance is from the detector face, to 
the center of  shielding



Activity/Shielding Fit Tool (Chi graphic)

The graphic in this tool is to help provide you an idea of  how well the data lines up to the model
◦ Left: chart shows you how many statistical deviations each peak is away from the model

◦ Right: chart shows you the multiple of  how far away from the model each peak-area is.  The error bars are 1-sigma 
statistical uncertainties.  
◦ E.x., if  the dot corresponding to a peak is at 2.0, that indicates that peak would give double the activity that is currently showing

Generally, if  after doing a “Perform Model Fit,” a peak is greater than maybe 5-or-so-sigma away from the 
nominal value, you should consider removing that peak from the fit, or checking that its associated with 
the correct gamma line, or that there isn’t an interfering nuclide that you aren’t currently fitting for
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Activity/Shielding Fit Tool (options)

◦ Multiple nuclides contribute to peak: if  two or more nuclides being fit for contribute to a peak, allow all 
of  the to contribute to calculating the expected peak area, not just the nuclide assigned to the peak

◦ Subtract Background Peaks: useful if  background peaks contribute to your isotope of  interest.  To enable 
this option you must have a background spectrum loaded, and you must have the background peaks fit in it

◦ To fit the peaks in a background spectrum, first load it as a foreground spectrum, fit the peaks, then load your foreground of  interest file, 
and from the “File Manager” tab select the first file as background

◦ Background peaks do not need nuclides associated with them; matching of  which peaks to subtract from which is based on energy

◦ Isotopes of  same element same age: If  you are fitting for the age of  a material, like Th, U, Pu, etc, and 
you want to constrain all isotopes for an element to be the same age, select this option

◦ Show Chi Graphic: Selects between the two different style graphics
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Activity/Shielding Fit Tool (more…)

Clicking on the gear icon brings up a menu that lets you:

◦ See a log of  calculations, which has a whole bunch of  details about what exactly went into the calculations

◦ You can save, export, import, or load a previous model.  Useful if  your model is complex.
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Activity/Shielding Fit Tool (general notes)

This tool requires use of  your critical thinking and spectroscopy knowledge – you can do things that 
don’t make sense
◦ E.x., if  you try to fit for atomic number of  shielding using two close-together peaks, or two high-energy 

peaks, you will get a nonsense answer (but you should also get a large error as well).  Or if  you fit for the age 
of  a nuclide that has already reached equilibrium, you might get a really large age (but also hopefully large 
uncertainty)

◦ InterSpec doesn’t currently do a great job of  detecting and notifying you of  degeneracies being fit for
◦ Large uncertainties are a “smell” of  these

You can only fit for as many quantities as you have peaks for

If  you are fitting for the effective atomic number of  your shielding, having one or more peaks below 
300 keV is usually necessary.

Always ask yourself  if  the results make sense.

Uncertainties given are only statistical.  Uncertainties about your DRF, peak-skew, distance, material 
composition, or other factors may dwarf  the statistical uncertainties
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Lets work an example problem together:66

A metal container was located that was giving off increased radiation 
A 5 minute spectrum was taken from 1 m away, along with a 5 minute 

representative background; both using the same 3x3 NaI detector☨

You would like to determine:

What nuclides are present inside the box?

The nuclide(s) activity?

How much shielding is present?

Detector 1 m

☨ 7.62 cm diameter by 7.62 cm long NaI crystal – will produce the conceptually same spectroscopic data as an identiFINDER or RadSeeker

(The next bunch of slides is for later reference – we’ll work it live)

Please load Example1.pcf as foreground, and 

Example1_background.pcf as the background



Example 1 (cont):67

The background peaks at 1460 keV (K40), 609 keV (Ra226), and 2614 keV (Th232) look to be at the expected energies

◦ The energy calibration is acceptable, and it looks like we got the correct files off  the detector



Example 1 (cont):68

There are two obvious photo-peaks in your item of  interest spectrum that are not in the background spectrum.

You can fit peaks by double-clicking near them.



Example 1 (cont):69

Lets figure out what nuclide causes these photopeaks by using the “Nuclide Search” tab

When on the “Nuclide 
Search” tab if  you click 
on a place in the spectrum 
– that energy is filled in to 
search on

The number of  energies 
can be changed by using 
the + and - icons



Example 1 (cont):70

Clicking on a nuclide will cause the reference photopeak lines for that nuclide to be shown

◦ Here Fm256 is clearly not right because we would see many other peaks



Example 1 (cont):71

It’s a little hard to see, but the reference lines for Na22 line up exactly with the observed peaks – and 
we aren’t missing any peaks we would expect for Na22 – so this is our nuclide

Its usually best to sort this table 
by the “Profile” column 
(default), but other ordering can 
be changed by clicking on the 
headers for other columns



Example 1 (cont):72

Now we need to assign nuclides to these peaks because reference lines were not showing before we fit the peaks:

If  you right-click on the peak, and go to the “Change 
Nuclide” menu-item, you can select Na22, or there are a 
number of  other possible isotopes that it could be from



Example 1 (cont):73

You can also assign nuclides to peaks, in a number of  other ways:

By typing the nuclide name 
into the “Peak Manager” tab

The “Peak Editor” tool (opened 
by right clicking on peak and 
selecting “Peak Editor…”)

Or if  you are showing reference 
photo-peak lines when you fit for 
a peak, the peak will automatically 
be associated with that nuclide

Mousing over a peak causes a 
pop-up that shows info about 
the peak, including nuclide



Example 1 (cont):74

Fit for the source activity using the “Activity/Shielding Fit” tool



Example 1 (cont):75

Select the detector 
response function you 
want to use by clicking 
here 



Example 1 (cont)76

Enter distance of  
measurement



Example 1 (cont):77

Select which peaks you 
would like to use



Example 1 (cont):78

Add a shielding

Here we added a 
single iron shielding

Make sure you are fitting for 
activity, and shielding thickness



Example 1 (cont)79

Click here to fit for desired quantities 



Example 1 (cont)80

We fit for 40 uCi of  Na22, with 3.4 cm of  Iron Shielding

◦ Truth level: 50 uCi at 3.48 cm Fe - not bad!



Example 1 (cont)81

This “Chi2” graphic shows you how many statistical sigmas the fit peak areas are off  from what is predicted for the 
fit activity and shielding

◦ Here we fit for two quantities (activity and shielding thickness), using two peaks, so both peak areas should be at essentially 
zero sigmas.  If  we had more peaks we would expect a distribution ranging between about ±5 sigmas (or maybe a little more)

True answer: 50 uCi, 3.48 cm Fe



Example 282

See: uranium_problem_one_question.pdf



End of day one

83


